Hytera

OWNER'S MANUAL

TETRA PORTABLE TERMINAL

TETRA 手持终端

Hytera

is the trademark or registered trademark of
Hytera Communications Corp., Ltd.
© 2013 Hytera Corp., Ltd. All Rights Reserved.
Address: HY Tower, Hi-Tech Industrial Park North, Binhuan Rd., Nanshan District, Shenzhen, China
Postcode: 518057
http://www.hytera.com

2013 Hytera Corp., Ltd.

http://www.hytera.com
Preface
Thanks for your favor in our product. To derive optimum performance from the product, please read this manual, the corresponding TETRA Terminal Series Feature Book and the Safety Information Booklet carefully before use.

This manual is applicable to the following model:
PT580H TETRA Portable Terminal
Copyright Information
Hytera is the trademark or registered trademark of Hytera Communications Co., Ltd. (the Company) in PRC and/or other countries or areas. The Company retains the ownership of its trademarks and product names. All other trademarks and/or product names that may be used in this manual are properties of their respective owners.

Disclaimer
The Company endeavors to achieve the accuracy and completeness of this manual, but no warranty of accuracy or reliability is given. All the specifications and designs are subject to change without notice due to continuous technology development. No part of this manual may be copied, modified, translated, or distributed in any manner without the express written permission of us.

We do not guarantee, for any particular purpose, the accuracy, validity, timeliness, legitimacy or completeness of the Third Party products and contents involved in this manual.

If you have any suggestions or would like to learn more details, please visit our website at: http://www.hytera.com.

RF Radiation Information
This product must be restricted to operations in an Occupational/Controlled RF exposure Environments. Users must be fully aware of the hazards of the exposure and able to exercise control over their RF exposure to qualify for the higher exposure limits.

RF Radiation Profile
Radio Frequency (RF) is a frequency of electromagnetic radiation in the range at which radio signals are transmitted. RF technology is widely used in communication, medicine, food processing and other fields. It may generate radiation during use.

RF Radiation Safety
In order to ensure user health, experts from relevant industries including science, engineering, medicine and health work with international organizations to develop standards for safe exposure to RF radiation. These standards consist of:

- American National Standards Institute (ANSI)/Institute of Electrical and Electronic Engineers (IEEE) C95. 1-1992;
- Institute of Electrical and Electronic Engineers (IEEE) C95. 1 – 1999;
- International Commission on Non-Ionizing Radiation Protection (ICNIRP) 1998;

EU Regulatory Conformance
As certified by the qualified laboratory, the product is in compliance with the essential requirements and other relevant provisions of the Directive 1999/5/EC. Please note that the above information is applicable to EU countries only.

FCC Regulations
Federal Communication Commission (FCC) requires that all radio communication products should meet the requirements set forth in the above standards before they can be marketed in the U.S. and the manufacturer shall post a RF label on the product to inform users of operational instructions, so as to enhance their occupational health against exposure to RF energy.

Operational Instructions and Training Guidelines
To ensure optimal performance and compliance with the occupational/controlled environment RF energy exposure limits in the above standards and guidelines, users should transmit no more than 50% of the time and always adhere to the following procedures:

- Your radio radiates measurable RF energy only while it is transmitting (during talking), not when it is receiving (listening) or in standby mode.
- Keep the radio at least 2.5 centimeters away from your body during transmission.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Conventions</td>
<td>2</td>
</tr>
<tr>
<td>Instructional Conventions</td>
<td>2</td>
</tr>
<tr>
<td>Notational Conventions</td>
<td>2</td>
</tr>
<tr>
<td>Key Operation</td>
<td>2</td>
</tr>
<tr>
<td>Term Explanation</td>
<td>2</td>
</tr>
<tr>
<td>Items in the Package</td>
<td>2</td>
</tr>
<tr>
<td>Product Overview</td>
<td>3</td>
</tr>
<tr>
<td>Product Controls</td>
<td>3</td>
</tr>
<tr>
<td>Programmable Keys</td>
<td>3</td>
</tr>
<tr>
<td>Before Use</td>
<td>3</td>
</tr>
<tr>
<td>Charging the Battery</td>
<td>3</td>
</tr>
<tr>
<td>Assembling the Accessories</td>
<td>3</td>
</tr>
<tr>
<td>Status Indication</td>
<td>4</td>
</tr>
<tr>
<td>Status Icon</td>
<td>4</td>
</tr>
<tr>
<td>LED Indicator</td>
<td>5</td>
</tr>
<tr>
<td>Menu Navigation</td>
<td>5</td>
</tr>
<tr>
<td>TMO Menu</td>
<td>5</td>
</tr>
<tr>
<td>DMO Menu</td>
<td>5</td>
</tr>
<tr>
<td>Basic Operations</td>
<td>6</td>
</tr>
<tr>
<td>Turning On/Off</td>
<td>6</td>
</tr>
<tr>
<td>Switching Operation Mode</td>
<td>6</td>
</tr>
<tr>
<td>Adjusting the Call Volume</td>
<td>6</td>
</tr>
<tr>
<td>Inputting through Keypad</td>
<td>6</td>
</tr>
<tr>
<td>Locking/Unlocking the Keypad</td>
<td>6</td>
</tr>
<tr>
<td>PIN Code Security and Changing</td>
<td>6</td>
</tr>
<tr>
<td>Managing the Contacts</td>
<td>6</td>
</tr>
<tr>
<td>Call Services</td>
<td>6</td>
</tr>
<tr>
<td>TMO</td>
<td>6</td>
</tr>
<tr>
<td>DMO</td>
<td>8</td>
</tr>
<tr>
<td>Message</td>
<td>8</td>
</tr>
<tr>
<td>Status Message</td>
<td>8</td>
</tr>
<tr>
<td>User Message</td>
<td>8</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>9</td>
</tr>
<tr>
<td>Care and Cleaning</td>
<td>9</td>
</tr>
<tr>
<td>Optional Accessories</td>
<td>10</td>
</tr>
<tr>
<td>Appendix</td>
<td>10</td>
</tr>
<tr>
<td>SSI&amp;TSI Dialing Rules</td>
<td>10</td>
</tr>
</tbody>
</table>
Document Conventions

For your better understanding of this manual, please read the following conventions first.

Instructional Conventions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>Indicates references that can further describe the related topics.</td>
</tr>
<tr>
<td>Caution</td>
<td>Indicates situations that could cause data loss or equipment damage.</td>
</tr>
</tbody>
</table>

Notational Conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“”</td>
<td>The quotation marks enclose the name of a software interface element. For example, click “OK”.</td>
</tr>
<tr>
<td>Bold</td>
<td>The text in boldface denotes the name of a hardware button. For example, press the PTT key.</td>
</tr>
<tr>
<td>- &gt;</td>
<td>The symbol directs you to access a multi-level menu. For example, to select “New” from the “File” menu, we will describe it as follows: File - &gt; New.</td>
</tr>
</tbody>
</table>

Key Operation

<table>
<thead>
<tr>
<th>Operation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short press</td>
<td>To press a key and release it quickly.</td>
</tr>
<tr>
<td>Long press</td>
<td>To press a key for the preset time (2s by default) and release it.</td>
</tr>
<tr>
<td>Hold</td>
<td>To press a key and do not release it.</td>
</tr>
</tbody>
</table>

Term Explanation

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual Call</td>
<td>A half-duplex or full-duplex call initiated by an individual user.</td>
</tr>
<tr>
<td>Group Call</td>
<td>A half-duplex call initiated by an individual user to a group.</td>
</tr>
</tbody>
</table>

Items in the Package

Please unpack carefully and check that all items listed below are received. If any item is missing or damaged, please contact your dealer.

<table>
<thead>
<tr>
<th>Portable Terminal</th>
<th>Battery</th>
<th>Belt clip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antenna</td>
<td>Charger</td>
<td>Power Adapter</td>
</tr>
<tr>
<td></td>
<td>Strap</td>
<td>Documentation Kit</td>
</tr>
</tbody>
</table>

Note: The frequency band is marked on the label of antenna; if not, refer to the label on the terminal for frequency band information.
**Product Overview**

**Product Controls**

<table>
<thead>
<tr>
<th>No.</th>
<th>Part Name</th>
<th>No.</th>
<th>Part Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SK1 (Side Key 1)</td>
<td>15</td>
<td>Antenna Connector</td>
</tr>
<tr>
<td>2</td>
<td>PTT (Push-to-talk)</td>
<td>16</td>
<td>Power On-Off/Volume Control Knob</td>
</tr>
<tr>
<td>3</td>
<td>SK2 (Side Key 2)</td>
<td>17</td>
<td>Half-duplex Microphone</td>
</tr>
<tr>
<td>4</td>
<td>Emergency Key</td>
<td>18</td>
<td>Accessory Contact Cover</td>
</tr>
<tr>
<td>5</td>
<td>LED Indicator</td>
<td>19</td>
<td>Options/Back Key</td>
</tr>
<tr>
<td>6</td>
<td>Antenna</td>
<td>20</td>
<td>End Key</td>
</tr>
<tr>
<td>7</td>
<td>Group Selector Knob</td>
<td>21</td>
<td>Navigation Key</td>
</tr>
<tr>
<td>8</td>
<td>Full-duplex Receiver</td>
<td>22</td>
<td>Battery Latch</td>
</tr>
<tr>
<td>9</td>
<td>LCD Display</td>
<td>23</td>
<td>Accessory Contact</td>
</tr>
<tr>
<td>10</td>
<td>Func/OK Key</td>
<td>24</td>
<td>Strap Hole</td>
</tr>
<tr>
<td>11</td>
<td>Answer/Call Key</td>
<td>25</td>
<td>Belt Clip</td>
</tr>
<tr>
<td>12</td>
<td>Half-duplex Speaker</td>
<td>26</td>
<td>Battery</td>
</tr>
<tr>
<td>13</td>
<td>Numeric Keypad</td>
<td>27</td>
<td>Charging Piece</td>
</tr>
<tr>
<td>14</td>
<td>Full-duplex Microphone</td>
<td>28</td>
<td></td>
</tr>
</tbody>
</table>

**Programmable Keys**

For enhanced convenience, you can request your dealer to program the keys (SKI, SK2, navigation key, answer/call key, numeric keys 1-9, *, # and 0) as the shortcuts to needed menus and functions. For the detailed introduction, please read the corresponding TETRA Terminal Series Feature Book.

**Before Use**

**Charging the Battery**

*Caution:* Make sure the radio is powered off during charging.

Only use the charger and battery specified by the Company. The charger LED indicator will indicate the charging process. See the figure below showing the steps for charging.

During charging, the LED indicator on the charger will indicate the charging status. The charging begins when the charger LED glows red. When charging is complete, the charger LED glows green.

See the following table for details.

**LED Indication**

<table>
<thead>
<tr>
<th>LED Indication</th>
<th>Charging Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flashes red slowly</td>
<td>Standby(no load)</td>
</tr>
<tr>
<td>Glows red</td>
<td>Charging</td>
</tr>
<tr>
<td>Glows orange</td>
<td>90% charged</td>
</tr>
<tr>
<td>Glows green</td>
<td>Fully charged</td>
</tr>
<tr>
<td>Flashes red rapidly</td>
<td>Failure</td>
</tr>
</tbody>
</table>

**Assembling the Accessories**

**Installing the SIM card**

If a SIM card is required to realize the End-to-End Encryption (E2EE) feature which should be purchased separately, please install the SIM card first.

1. Turn off the terminal, and then slide the battery latch upwards to unlock the battery.
2. Loosen the screw fixing the SIM card cover, remove the cover, and then place the card in the holder properly as shown below.
3. Replace the cover and tighten the screw as shown below.
Attaching the Antenna
Turn the antenna clockwise to fasten it.

To remove the antenna, rotate it counter-clockwise.

Attaching the battery
1. Fit the battery into the battery slot properly as shown by arrow ① below.
2. Slightly press the bottom of the battery until a click is heard as shown by arrow ② below.

Attaching the Belt Clip
1. Remove the two screws on the back of the terminal.
2. Align the screw holes on the belt clip with those on the terminal’s body, and then tighten the screws as shown below.

To remove the belt clip, loosen the screws. Please keep the screws properly. It is recommended to replace them to the terminal.

Assembling the Audio Accessory/Programming Cable
1. Loosen the screws on the accessory contact cover, and open the cover as shown below.
2. Align the pins on plug with the accessory contact.
3. Tighten the screws on the plug.

To remove the accessory, loosen the screw and pull out the plug.

After the above assembly procedure, the terminal is ready for use.

Caution: When you are using an external accessory, waterproof performance of the radio may get affected.

Status Indication

Status Icon

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery Strength</td>
<td><img src="image" alt="Battery Strength Icon" /></td>
<td>The battery is low. More bars indicate better battery strength.</td>
</tr>
<tr>
<td>RSSI</td>
<td><img src="image" alt="RSSI Icon" /></td>
<td>The terminal has not registered with the network (applicable for TMO only). More bars indicate better signal strength.</td>
</tr>
<tr>
<td>Message</td>
<td><img src="image" alt="Message Icon" /></td>
<td>Unread message(s). The Inbox is full.</td>
</tr>
<tr>
<td>Operation Mode</td>
<td><img src="image" alt="Operation Mode Icon" /></td>
<td>The terminal is operating in TMO. The terminal is operating in DMO. The terminal is operating in fall-back mode.</td>
</tr>
<tr>
<td>Profile</td>
<td><img src="image" alt="Profile Icon" /></td>
<td>Silent Normal Vibration</td>
</tr>
<tr>
<td>Accessory</td>
<td><img src="image" alt="Accessory Icon" /></td>
<td>The audio accessory is connected. A GPS module is connected and the valid GPS data is received. Valid GPS data can be received, and the audio accessory has been connected. A GPS module is connected and no valid GPS data is received. No valid GPS data can be received, and the audio accessory has been connected.</td>
</tr>
</tbody>
</table>
### LED Indicator

<table>
<thead>
<tr>
<th>LED Indication</th>
<th>Terminal Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glows red</td>
<td>Transmitting</td>
</tr>
<tr>
<td>Glows green</td>
<td>Receiving</td>
</tr>
<tr>
<td>Flashes green slowly</td>
<td>Channel free in DMO</td>
</tr>
<tr>
<td>Glows orange.</td>
<td>Channel busy in DMO</td>
</tr>
</tbody>
</table>

### Menu Navigation

The following menu lists show the full menus of the terminal in TMO and DMO. You can select your needed menus to be displayed via your dealer. To select and confirm the options in the menu, operate as follows: in the home screen, you can press the **Func/OK** key to enter the “Func” menu, or press the **Options/Back** key to enter the “Options” menu; then press the **Up/Down** key on the **Navigation** key to select the needed menu, finally press the **Func/OK** key to confirm. In sections introducing operations, a menu path is provided for your convenience, e.g. **Message -> Create Msg**.

### TMO Menu
Basic Operations

Turning On/Off
To turn on the terminal, rotate the Power On-Off/Volume Control knob clockwise. Then the LED indicator flashes green, and the terminal shows the power-up screen and sounds power-up alert. Upon successful powering on, the terminal enters the home screen. In TMO, after being turned on, the terminal will logon to the network. In DMO, the terminal will be ready for use after being turned on.

To turn off the terminal, rotate the Power On-Off/Volume Control knob counter-clockwise until a click is heard.

Switching Operation Mode
This terminal can operate in either TMO or DMO. To switch the operation mode, press the Options/Back key in the home screen to enter the “Options” menu, and then select “TMO” or “DMO”.

Adjusting the Call Volume
Rotate the Power On-Off/Volume Control knob clockwise to increase the call volume, or counter-clockwise to decrease the volume. After the adjustment, the terminal will save the settings and return to the former screen automatically.

Inputting through Keypad
You can use the numeric keypad to enter user alias and number, edit messages, etc. The terminal supports these input methods: English and Number. To switch the input method, press the # or * key on the numeric keypad. In either input method, you can enter special characters and common punctuations by pressing 1, enter “#” by pressing # and enter a space by long pressing this key. As for other language input methods (depending on your customization), operate accordingly.

Locking/Unlocking the Keypad
To enable the keypad lock, enter the Func menu by pressing the Func/OK key in the home screen, and then go to “Settings -> KP Lock -> On”. After this feature is enabled, keypad will get locked automatically when the preset time (preset by the dealer) expires. To unlock the keypad, press the Func/OK key and then *

Apart from locking the keypad via menu, you can lock the keypad quickly and temporarily by pressing the Func/OK key and then # directly in the home screen.

PIN Code Security and Changing
PIN code can prevent unidentified user from using your terminal. To enable or disable the PIN Code feature, enter the Func menu from the home screen by pressing the Func/OK key, then go to “Settings -> Security -> PIN Code”. Every time you need to change the settings, it is required to input the PIN code first (default PIN code: 1234, preset by the dealer).

With this feature enabled, you will need to enter the correct PIN code prior to operating the terminal after turning it on. If you input the wrong code for continuous 3 times (predefined by the dealer), the terminal will be locked. In this case, you will need to enter the correct PUK code (default PUK code: 12345678) to reset the PIN code.

To change the PIN code, go to “Settings -> Security -> ChangePIN” from the home screen, and input the correct current PIN code prior to changing the code.

Managing the Contacts

Contact List
To view the list, go to the “Func. -> PhoneBook” from the home screen.

New Contact
To add a new contact, you can enter the Func menu by pressing Func/OK key and go to “PhoneBook”.

Then press the Func/OK key to enter “Options -> New Contact” to add a new contact: enter the contact’s alias in the editing screen, and press the Func/OK key to enter the “Input No.” screen to input the contact number. And press the Func/OK key again to select the call type (“Private No.”, “PABX” or “PSTN”). Finally, press Func/OK key to confirm.

Viewing the Memory
To view the phonebook memory, you can enter the Func menu by pressing the Func/OK key, and go to “PhoneBook” menu; then press Func/OK to enter “Memory”.

Call Services

TMO

Individual Call
In TMO, an individual call can be initiated either as a half-duplex call or full-duplex call, which can be received without pressing any key (Direct Signaling) or by pressing the Answer/Call key or PTT (Hook Signaling). Contact your dealer for such programming as well as more details.

Initiating an Individual Call
• Via Menu

In the home screen, press Func/OK key to enter the “PhoneBook” or “Call Log” submenu, and select a contact. Then press PTT to initiate a half-duplex call, or press # to initiate a full-duplex call.

• Via Manual Dial

In the home screen, to initiate a half-duplex individual call, input the number you want to call through the keypad, and then press PTT. To initiate a full-duplex individual call, input the number you want to call through
the keypad, and press repeatedly to select the call type “Private No.”. Then press to initiate a full-duplex call.

**Note:**
- Entry of individual numbers must comply with the SSI&TSI dialing rules. See “SSI&TSI Dialing Rules” in “Appendix” for more details.
- Calls will end automatically if the predefined call timer expires.

**Answering an Individual Call**

- **Half-duplex Individual Call**
  
  » If it is an incoming call with Direct Signaling, there will be an alert tone to inform the called party that a call is received.
  
  » If it is an incoming call with Hook Signaling, the terminal sounds alert and vibrates to inform the called party that there is an incoming call. And to receive the call, the PTT key or Func/OK key should be pressed.

To take the talk rights during the call, there are two situations: 1) if you have no pre-emptive priority, hold down PTT to talk after the talking party stops talking and releases its PTT; 2) if you have already been programmed with pre-emptive priority, hold down PTT to talk at any time.

- **Full-duplex Individual Call**
  
  » If it is an incoming call with Direct Signaling, there will be an alert tone to inform the called party that a call is received.
  
  » If it is an incoming call with Hook Signaling, the terminal sounds alert and vibrates to inform the called party that there is an incoming call. And to receive the call, the PTT, Func/OK key or should be pressed.

After the call is established, both parties can talk at any time, with no need to use any key.

**Hanging up/ Rejecting an Individual Call**

When initiating the individual call, press the Options/Back key or to terminate it.

In the presence of an incoming individual call, press the Options/Back key or to reject it.

In the process of an individual call, any party can press to talk after the talking party stops talking and releases its PTT.

**Group Call**

**Initiating a Group Call**

In the home screen, you can initiate a group call to the default group by pressing PTT. To call other groups, please do as follows:

1. In the home screen, rotate the Group Call Selector knob to select a group. Please perform this step as soon as the icon appears; otherwise, you may fail to select.
2. Press the Func/Ok key to confirm your selection.
3. Press PTT to initiate a group call to this group.

**Answering a Group Call**

You can receive a group call without any operation. To take the talk rights during the call, there are two situations: 1) if you have no pre-emptive priority, hold down PTT to talk after the talking party stops talking and releases its PTT; 2) if you have already been programmed with pre-emptive priority, hold down PTT to talk at any time.

**Hanging up a Group Call**

The calling party can press to exit a group call. And for the called parties in a group call, only those enabled with “Hang Up” feature (programmable by the dealer) can exit a group call.

**Telephone Call**

The telephone call is a full-duplex individual call with Hook signaling. To initiate the call, follow the steps below.

**Initiating a Telephone Call**

1. Select a gateway.

In the home screen, press Options/Back key to enter the “PSTN GATE” or “PABX GATE” submenu. Select an appropriate gateway, and press Func/OK key to confirm.

2. Input a telephone number.

Return to the home screen by pressing . Input a PABX or PSTN number, which is composed of a prefix (specified by the gateway, please contact the system administrator) and the telephone number of the target contact.

3. Select a call type.

Select “PABX” or “PSTN” through the Func/OK key with the screen-icon.

4. Press to initiate the call.

To answer or hang up/reject the call; see the “Individual Call” in “TMO”.

**Emergency Call**

**Initiating an Emergency Call**

Press the Emergency key and you can initiate an emergency call to the predefined contact. Any individual contact, group contact, default group, PSTN or PABX contact can be predefined as the emergency contact.

There are two levels for emergency call: emergency priority and pre-emptive priority 3, which can be programmed by your dealer. The emergency priority is endowed with the higher privilege; thus a call with such priority can break any other call with pre-emptive priority 3, as well as calls with lower priorities.

**Answering an Emergency Call**

The emergency call is always received automatically. During an emergency call, the calling party can talk with no need to use any key. If another member needs to talk, he/she should hold down PTT only after the talking party stops talking and releases its PTT.

**Hanging up an Emergency Call**

See the corresponding part of “Individual call” or “Group call” in accordance with the call type of the predefined contact.
DMO

Individual Call
In DMO, an individual call can be initiated only as a half-duplex call.

Initiating an Individual Call
In the home screen, directly input the number you want to call through the keypad, or press Func/OK key to enter the “PhoneBook” or “Call Log” submenu, and select a contact. Then press PTT to initiate the call.

Note: Entry of individual numbers must comply with the SSI&TSI dialing rules. See “SSI&TSI Dialing Rules” in “Appendix” for more details.

Answering an Individual Call
You can receive an individual call in DMO automatically. During the call, you can hold down PTT to talk after the initiating party stops talking and releases its PTT.

Hanging up an Individual Call
The calling party can press to terminate the call. And the called party can press to exit the call.

Group Call
Group calls in DMO is the same as that in TMO. Please refer to operation method described in “Group Call” in the above “TMO” section.

Emergency Call
In DMO, emergency calls are endowed with emergency priority only. Please refer to operation method described in “Emergency Call” in the above “TMO” section.

Message

Status Message
Status message, which should be programmed by your dealer only, can facilitate instant messaging of the frequently-used messages. You can only send or view rather than editing the status messages. When the message is sent successfully, the target terminal will receive either the status ID of the status message (if the message text has not been predefined via CPS) or the predefined text (if the message text has been predefined via CPS).

Note: The “Fixed Status Message” and the “Status Message” are predefined by the dealer via the CPS.

Sending a User Message
- Press the Func/OK key and navigate to “Message -> Create Msg -> StatusMsg -> Sel Msg”. Select a desired status message, and press the Func/OK key to proceed. Choose either an individual or a group as the target contact, input the appropriate number and press Func/OK to send the message.
- Long press the programmed Send StatusMsg key to send the preset status message directly

Viewing the User Message
When the icon appears in the status bar, it indicates there is/are unread message(s). Do as follows to view it:
- In the prompt screen for an unread message, press the Func/OK key to enter the Inbox, and press Func/OK key again to read.
- In the home screen, press the Func/OK key and navigate to “Message -> Inbox”. Then you can press Func/OK key to view the unread message.

User Message

TMO

Editing a User Message
Press the Func/OK key and navigate to “Message -> Create Msg -> User Msg”. Press Func/OK again to edit a user message.

Sending a User Message
After editing, press Func/OK to confirm. Then select the target contact and decide whether to send it as a flash message.

Note: If the message is sent as a flash message, the receiving party can preview all the content in a predefined time period without any operation. Once the time period expires, the home screen will get restored, with the icon displaying on the status bar.

Viewing the User Message
When the icon appears in the status bar, it indicates there is/are unread message(s). Do as follows to view it:
- In the prompt screen for an unread message, press the Func/OK key to enter the Inbox, and press Func/OK key again to read.
- In the home screen, press the Func/OK key and navigate to “Message -> Inbox”. Then you can press Func/OK key to view the unread message.

DMO

Editing a User Message
Press the Func/OK key and navigate to “Message -> Create Msg -> User Msg”. Press Func/OK key again to edit a user message.

Sending a User Message
After editing, press Func/OK to confirm. Then choose either to send to an individual or to a group, and then input the target contact and press Func/OK key to send the message.

Viewing the User Message
Operate in the same way as that described in "Viewing the User Message" in the above “TMO” section.
### Troubleshooting

<table>
<thead>
<tr>
<th>Phenomenon</th>
<th>Analysis</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminals cannot be powered on.</td>
<td>The battery power gets too low to supply the terminal.</td>
<td>Charge for the battery.</td>
</tr>
<tr>
<td>Network registration fails or network can not be found.</td>
<td>The terminal is operating in DMO.</td>
<td>Switch to TMO mode.</td>
</tr>
<tr>
<td></td>
<td>The terminal gets out of the network coverage (in TMO).</td>
<td>Check the signal strength. Make sure the terminal is within the network coverage.</td>
</tr>
<tr>
<td></td>
<td>The terminal is not granted network access.</td>
<td>Contact the network operator for the terminal authorization.</td>
</tr>
<tr>
<td>Calls cannot be initiated.</td>
<td>The terminal or the called party is not within the network coverage.</td>
<td>Check the signal strength. Make sure the terminal is within the network coverage.</td>
</tr>
<tr>
<td></td>
<td>The terminal operates in an improper mode.</td>
<td>Check the operation mode. Make sure the terminal works in the right mode.</td>
</tr>
<tr>
<td>A group call can not be initiated or received.</td>
<td>The terminal is not a member of the group.</td>
<td>Check whether the terminal is a member of the group. If not, contact your dealer to add the terminal to the group.</td>
</tr>
<tr>
<td></td>
<td>The terminal is not authorized to access the target group.</td>
<td>Contact the network operator for the terminal authorization.</td>
</tr>
<tr>
<td>Calls are always interrupted.</td>
<td>The current channel is assigned to emergency calls or other calls with higher priority.</td>
<td>Wait until the channel becomes available and try again.</td>
</tr>
<tr>
<td>A half-duplex call can not be established.</td>
<td>The predefined time period for establishing a call expires.</td>
<td>Make sure the call is established within the predefined time period.</td>
</tr>
<tr>
<td></td>
<td>The channel is occupied by another terminal with higher call priority.</td>
<td>Wait until the channel becomes available and try again.</td>
</tr>
<tr>
<td></td>
<td>The channel resources are allocated to other services due to overloaded network.</td>
<td>Wait until the channel becomes available and try again.</td>
</tr>
<tr>
<td>Abnormal disconnection occurs during a call.</td>
<td>The terminal gets out of the network coverage (in TMO).</td>
<td>Check the signal strength. Make sure the terminal is within the network coverage.</td>
</tr>
<tr>
<td></td>
<td>The terminal operates at an unfavorable position where communication may be blocked by high buildings or frustrated in the underground areas (in DMO).</td>
<td>Move to an open and flat area, and restart the terminal.</td>
</tr>
<tr>
<td>As for the same status message ID, the content displayed at the receiving party is different from that of the sending party.</td>
<td>The parties have associated the same status message ID with different contents.</td>
<td>Make sure the status message ID is associated with the same content.</td>
</tr>
</tbody>
</table>

If the above solutions cannot fix your problems, or you may have some other queries, please contact us or your local dealer for more technical support.

### Care and Cleaning

To guarantee optimal performance as well as a long service life of the product, please follow the tips below.

#### Product Care
- Do not pierce or scrape the product.
- Keep the product far away from substances that can corrode the circuit.
- Do not hold the product by its antenna or earpiece cable directly.
- Attach the accessory jack cover when the product is not in use.

#### Product Cleaning

<table>
<thead>
<tr>
<th>Caution: Power off the product before cleaning.</th>
</tr>
</thead>
</table>

- Clean up the dust and fine particles on the product surface and charging piece with a clean and dry lint-free cloth or a brush regularly.
- Use neutral cleanser and a non-woven fabric to clean the keys, control knobs and front case after long-time use. Do not use chemical preparations such as stain removers, alcohol, sprays or oil preparations, so as to avoid surface case damage.
- Make sure the product is completely dry before use.
Optional Accessories

The following items are the main optional accessories for the product, and please consult your local dealer for more other accessories.

**Caution:** Use the accessories specified by the Company only. If not, we shall not be liable for any losses or damages arising out of use of unauthorized accessories.

**Power Supply**
- MCA05  Battery Optimizing System
- BL2505  Li-Ion Battery (2500mAh)
- MCA06  MCU Multi-unit Rapid-rate Charger (for Li-Ion/Ni-MH batteries)
- MCA08  MCU Multi-unit Rapid-rate Charger (for Li-Ion/Ni-MH batteries)
- CH10A06  Dual-Pocket MCU Charger (for Li-Ion/Ni-MH battery)
- CHV09  Vehicle Adapter for Charger

**Audio Accessory**
- ESN12  Earbud
- EHN16  C-Earset
- EHN17  Swivel Earset
- EWN09  Wireless Surveillance Earpiece with Inductive Neckloop
- EAN23  Remote Earset with Transparent Acoustic Tube
- EAN17  3-Wire Surveillance Earpiece with Transparent Acoustic Tube (Beige)
- EAN17  3-Wire Surveillance Earpiece with Transparent Acoustic Tube (Black)
- SM18N5  Remote Speaker Microphone (IP67)
- SM18N3  Remote Speaker Microphone (IP54)
- ES-01  Receive-Only Earbud (used with SM18N3)
- EH-01  Receive-Only C-Earset (used with SM18N3)
- EH-02  Receive-Only Swivel Earset (used with SM18N3)
- ES-02  Receive-Only Earpiece with Transparent Acoustic Tube (used with SM18N3)

**Others**
- LCY003  Leather Carrying Case for terminal with thin battery (swivel)
- LCY006  Leather Carrying Case for terminal with thick battery (swivel)
- PC36  Programming Cable (USB Port)

**Appendix**

**SSI&TSI Dialing Rules**
In the TETRA system, subscribers are distinguished by different identities. Each subscriber is assigned with a unique short subscriber identity (SSI), which serves a part of the TETRA subscriber identity (TSI). And TSI is generally composed in this way: Mobile Country Code (MCC) + Mobile Network Code (MNC) + SSI. To initiate an individual call, please dial the SSI or TSI in compliance with the rules below.

- **SSI Dialing**
  
  Make sure there are not more than 8 digits.

- **TSI Dialing**

  - **MNC+SSI:**
    1) Input the MNC as it is;
    2) SSI must be 8 digits long. Add 0 before the first digit of SSI which is shorter than 8 digits. For example, when MNC is 20 and SSI is 504, you need to input 20000000504.
致用户
非常感谢您对我们产品的青睐！为了确保您最大限度地享用本产品所带来的各种便利，请于使用前详细阅读本手册、《TETRA 终端基本功能手册》及《安全信息手册》。
本手册适用于以下机型：
PT580H TETRA 手持终端
版权限制

Hytera为海能达通信股份有限公司（以下简称“我司”）在中华人民共和国和世界其他国家和地区的商标或注册商标。我司仅对自有商标及产品名称享有所有权。本手册中可能提及的其他商标和产品名称为各自所有者所有。

免责声明

本手册在编制过程中力求内容的准确性和完整性，但对于可能出现的错误或疏漏，我司不承担任何责任。由于技术的不断发展，我司保留不通知而更改产品设计与规格的权利。未经我司事先书面授权，不得以任何形式对本手册进行复制、修改、翻译和散发。

本手册中涉及的第三方产品和内容归第三方所有，我司对其准确性、有效性、及时性、合法性或完整性均不提供保证。

如需更多信息或对本手册有任何建议，欢迎访问我们的网站：http://www.hytera.com，或拨打我司服务热线400-830-7020。

射频辐射信息

本产品仅限于能够满足射频能量辐射要求的职业应用。使用者必须清楚了解射频辐射危害并可采取相应措施，满足射频辐射限定要求。

射频辐射常识

射频指可以辐射到空间的电磁频率，是通讯、医疗、食品加工等领域广泛使用的一种技术，在使用过程中会产生一定的射频辐射。

射频辐射安全

为了确保用户的身心健康，来自科学、工程、医药、健康和工业的专家们与相关组织共同研究制定了射频辐射标准和准则，如下所示：

- 美国联邦通信委员会联邦政府法规汇编第47卷第2部分J子部分。
- 国际非电离辐射防护委员会(ICNIRP)于1998年颁布的标准。
- 电气和电子工程师协会标准C95.1-1999版。
- 国际非电离辐射防护委员会(ICNIRP)于1998年颁布的标准。

美国联邦通信委员会监管要求

按照美国联邦通信委员会的监管要求，本产品必须符合美国联邦通信委员会射频辐射限定规定，否则不能在美国市场上销售。并要求制造商可通过在产品上张贴标签的方式，告知用户应注意的事项，提高用户的防辐射意识。

射频辐射控制及操作说明

为了使产品发挥最佳性能及确保符合上述标准中有关职业或受控环境中的射频辐射限定要求，发送时间不得超过额定因数的50%，且需遵照下列说明：

- 天线增益不得超过5dBi(UHF)和3.5dBi(VHF)。
- 天线的安装需按照厂商或供应商的要求进行，且安装处与人体的距离不得少于1米。

欧盟指令符合性声明

本产品经独立第三方机构认证，符合欧盟指令“1999/5/EC”中的相关要求。请注意，本声明仅适合欧盟国家。
目录

阅读约定 .......................................................................................................................... 2
标识符号 .......................................................................................................................... 2
界面元素 .......................................................................................................................... 2
按键操作 .......................................................................................................................... 2
术语说明 .......................................................................................................................... 2
包装清单 .......................................................................................................................... 2
熟悉本产品 ....................................................................................................................... 2
部件介绍 .......................................................................................................................... 2
可编程键 .......................................................................................................................... 2
用前准备 .......................................................................................................................... 3
充电 .................................................................................................................................. 3
安装附件 .......................................................................................................................... 3
状态指示 .......................................................................................................................... 4
状态栏图标 ....................................................................................................................... 4
LED指示灯 ........................................................................................................................ 4
菜单导航 .......................................................................................................................... 4
集群模式 (TMO) 菜单 ...................................................................................................... 4
直通模式 (DMO) 菜单 ...................................................................................................... 5
基本操作 .......................................................................................................................... 5
开机与关机 ....................................................................................................................... 5
工作模式切换 .................................................................................................................. 5
通话音量调节 ................................................................................................................... 5
键盘输入 .......................................................................................................................... 5
键盘锁定及解锁 .............................................................................................................. 5
PIN 码保护与更改 ......................................................................................................... 6
联系人管理 ....................................................................................................................... 6
呼叫 .................................................................................................................................. 6
TMO 模式 ......................................................................................................................... 6
DMO 模式 ........................................................................................................................ 7
短信息 ................................................................................................................................ 7
状态信息 .......................................................................................................................... 7
用户信息 ............................................................................................................................ 7
故障处理指南 .................................................................................................................. 8
保修范围与期限 ............................................................................................................. 8
保养与清洁 ....................................................................................................................... 8
选购配件 ......................................................................................................................... 9
附录 .................................................................................................................................. 9
SSI&TSI 拨号方式 .......................................................................................................... 9
阅读约定

为方便您更好地理解手册内容，使用本手册前，请阅读如下约定。

标识符号

<table>
<thead>
<tr>
<th>符号</th>
<th>意义</th>
</tr>
</thead>
<tbody>
<tr>
<td>备注</td>
<td>表示对正文内容的补充、说明和强调。</td>
</tr>
<tr>
<td>注意</td>
<td>表示可能导致设备损坏或数据丢失的事项。</td>
</tr>
</tbody>
</table>

界面元素

<table>
<thead>
<tr>
<th>格式</th>
<th>意义</th>
</tr>
</thead>
<tbody>
<tr>
<td>“”</td>
<td>该符号表示软件界面控件名称，例如：单击“确定”。</td>
</tr>
<tr>
<td>【 】</td>
<td>该符号表示硬件界面控件名称，例如：按【PTT】键。</td>
</tr>
<tr>
<td>-&gt;</td>
<td>该符号用于对多级菜单进行逐级指引，例如：选择“文件”菜单下的“新建”，表示为：“文件-&gt;新建”。</td>
</tr>
</tbody>
</table>

按键操作

<table>
<thead>
<tr>
<th>操作</th>
<th>定义</th>
</tr>
</thead>
<tbody>
<tr>
<td>短按</td>
<td>按下某按键并快速松开。</td>
</tr>
<tr>
<td>长按</td>
<td>按下某按键达预编程时间（默认为2秒）后松开。</td>
</tr>
<tr>
<td>按住</td>
<td>一直按住某按键。</td>
</tr>
</tbody>
</table>

术语说明

<table>
<thead>
<tr>
<th>术语</th>
<th>说明</th>
</tr>
</thead>
<tbody>
<tr>
<td>个呼</td>
<td>个呼是对单个用户发起呼叫。</td>
</tr>
<tr>
<td>组呼</td>
<td>组呼是单个用户对组内的所有用户发起呼叫。</td>
</tr>
<tr>
<td>半双工</td>
<td>半双工通信又称双向交替通信。指通信双方都可以发送或接收语音，但双方不能同时发送或接收的一种通信方式。</td>
</tr>
<tr>
<td>全双工</td>
<td>全双工通信又称全双工同时通讯。指通信双方都可以同时发送和接收语音。</td>
</tr>
<tr>
<td>直通模式（DMO）</td>
<td>在直通模式下，终端之间可直接进行半双工通信，不受网络限制。但用户无法使用需网络支持的功能，例如电话呼叫。</td>
</tr>
</tbody>
</table>

包装清单

包装盒内含有以下物品。如有任何物品丢失或损坏，请与您所购产品的经销商联系。

<table>
<thead>
<tr>
<th>序号</th>
<th>部件名称</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SK1（侧键1）</td>
</tr>
<tr>
<td>2</td>
<td>PTT键（发射按键）</td>
</tr>
<tr>
<td>3</td>
<td>SK2（侧键2）</td>
</tr>
<tr>
<td>4</td>
<td>紧急呼叫键</td>
</tr>
<tr>
<td>5</td>
<td>LED指示灯</td>
</tr>
<tr>
<td>6</td>
<td>天线</td>
</tr>
<tr>
<td>7</td>
<td>组呼选择旋钮</td>
</tr>
<tr>
<td>8</td>
<td>全双工受话器</td>
</tr>
<tr>
<td>9</td>
<td>LCD显示屏</td>
</tr>
<tr>
<td>10</td>
<td>功能/确认键</td>
</tr>
<tr>
<td>11</td>
<td>接听/呼叫键</td>
</tr>
<tr>
<td>12</td>
<td>半双工扬声器</td>
</tr>
<tr>
<td>13</td>
<td>数字键盘</td>
</tr>
<tr>
<td>14</td>
<td>全双工麦克风</td>
</tr>
<tr>
<td>15</td>
<td>天线接口</td>
</tr>
<tr>
<td>16</td>
<td>电源开关/音量旋钮</td>
</tr>
<tr>
<td>17</td>
<td>半双工麦克风</td>
</tr>
<tr>
<td>18</td>
<td>附件接口盖</td>
</tr>
<tr>
<td>19</td>
<td>选项/返回键</td>
</tr>
<tr>
<td>20</td>
<td>吊挂键</td>
</tr>
<tr>
<td>21</td>
<td>导航键</td>
</tr>
<tr>
<td>22</td>
<td>电池推钮</td>
</tr>
<tr>
<td>23</td>
<td>附件接口</td>
</tr>
<tr>
<td>24</td>
<td>吊绳孔</td>
</tr>
<tr>
<td>25</td>
<td>皮带夹</td>
</tr>
<tr>
<td>26</td>
<td>电池</td>
</tr>
<tr>
<td>27</td>
<td>电池充电极片</td>
</tr>
</tbody>
</table>

术语

直通模式（TMO）：在集群模式下，终端通过TETRA网络进行半双工和全双工通信，用户可以使用需网络支持的功能。若在TMO模式下操作，首先必须在网络运营商处注册，以获得服务提供商的许可，且终端必须处于网络覆盖范围内。

熟悉本产品

部件介绍

可编程键

为提高操作便利性，本产品【SK1】、【SK2】、导航键、接听/呼叫键、数字键1-9、【 】和 【 】为可编程键，可由经销商设置为快捷功能键（可编程功能介绍请参考《TETRA终端基本功能手册》）。
用前准备

充电

注意：充电时请务必保证本产品处于关机状态。

请使用我司指定的充电座对电池进行充电，充电座的指示灯显示充电状态（见下表）。充电示意图如下图所示。

<table>
<thead>
<tr>
<th>指示灯状态</th>
<th>当前充电状态</th>
</tr>
</thead>
<tbody>
<tr>
<td>红色慢闪</td>
<td>空载</td>
</tr>
<tr>
<td>红色长亮</td>
<td>正充电</td>
</tr>
<tr>
<td>橙色长亮</td>
<td>已充满90%</td>
</tr>
</tbody>
</table>

1. 将电源适配器的插头插入电源插座，如图示①。
2. 将电源适配器的另一端插入充电座背面的插孔，如图示②。
3. 将电池或装有电池的主机正确插入充电座，如图示③。

充电座上的指示灯显示充电状态。指示灯红灯长亮时，表示充电开始。指示灯绿灯长亮时，表示充电完成。具体如下表所示。

备注：
- 为获得最佳电池性能，首次充电时，请充满5小时。
- 请参阅《安全信息手册》，以获取必要的电池安全信息。

安装SIM卡

若您购买了端到端加密（E2EE）功能，并已设置为通过外置SIM卡进行加密，请用如下方式安装SIM卡。
1. 将终端底部的电池推钮往上提起，取出电池。
2. 拧开支机SIM卡盖螺钉，将SIM卡正确放入SIM卡槽内。
3. 将SIM卡盖重新安装至主机，用螺钉固定SIM卡盖。

安装天线

沿顺时针方向旋转天线直至旋紧。

若需取下天线，逆时针旋转即可。

安装电池

1. 将电池顶部凸起插入主机电池槽顶部，如图中①所示。
2. 轻压电池底部，直至听到“咔嗒”声，如图中②所示。

安装皮带夹

1. 拧开支机后壳皮带夹螺钉。
2. 将皮带夹的螺钉孔对准主机背部的螺钉孔，然后用螺钉锁紧。

安装音频附件/编程线

1. 逆时针旋转附件接口盖螺钉并按箭头所示方向打开附件接口盖。
2. 将音频附件或编程线的插头对准主机附件接口。
3. 拧紧附件插头/编程线插头上的螺钉。
状态指示

状态栏图标

<table>
<thead>
<tr>
<th>图标名称</th>
<th>图标</th>
<th>本产品状态</th>
</tr>
</thead>
<tbody>
<tr>
<td>电池电量标识</td>
<td>![电池电量图标]</td>
<td>电池电量不足</td>
</tr>
<tr>
<td>中继器连接状态标识</td>
<td>![中继器图标]</td>
<td>中继器连接状态标识（仅适用集群模式）</td>
</tr>
<tr>
<td>信号强度标识</td>
<td>![信号强度图标]</td>
<td>信号条数越多，信号越强</td>
</tr>
<tr>
<td>信息标识</td>
<td>![信息图标]</td>
<td>有未读短信/收件箱已满</td>
</tr>
<tr>
<td>工作模式标识</td>
<td>![工作模式图标]</td>
<td>处于集群模式（TMO）/处于直通模式（DMO）/处于故障弱化模式</td>
</tr>
<tr>
<td>情景模式标识</td>
<td>![情景模式图标]</td>
<td>正常模式/无声模式/振动模式</td>
</tr>
<tr>
<td>音频附件标识</td>
<td>![音频附件图标]</td>
<td>音频附件已接入</td>
</tr>
<tr>
<td>GPS状态标识</td>
<td>![GPS状态图标]</td>
<td>GPS成功定位/已启用GPS但未成功定位</td>
</tr>
<tr>
<td>通话状态标识</td>
<td>![通话状态图标]</td>
<td>正在通话</td>
</tr>
<tr>
<td>通话组选择标识</td>
<td>![通话组选择图标]</td>
<td>正在选择通话组</td>
</tr>
</tbody>
</table>

LED指示灯

<table>
<thead>
<tr>
<th>指示灯状态</th>
<th>本产品状态</th>
</tr>
</thead>
<tbody>
<tr>
<td>红灯长亮</td>
<td>正在发起呼叫</td>
</tr>
<tr>
<td>绿灯长亮</td>
<td>正在接收呼叫</td>
</tr>
<tr>
<td>绿灯慢闪</td>
<td>DMO信道空闲状态</td>
</tr>
<tr>
<td>橙灯长亮</td>
<td>DMO信道繁忙状态</td>
</tr>
</tbody>
</table>

菜单导航

下图分别为本产品TMO模式和DMO模式的菜单结构，您可以通过经销商配置是否显示各菜单项。若需配置菜单下各选项，按【功能确认】键或【返回/选项】键进入主菜单，再通过【方向】键中【上移】键/【下移】键定位所需菜单或选项，选择预设项，按【功能/确认】键进行确认以完成设置。本文档介绍菜单操作时，仅介绍菜单项的顺序，例如，进入编辑短信的路径为“短信息 -> 编辑信息”。

集群模式 (TMO) 菜单

下图分别为本产品TMO模式和DMO模式的菜单结构，您可通过经销商配置是否显示各菜单项。若需配置菜单下各选项，按【功能确认】键或【返回/选项】键进入主菜单，再通过【方向】键中【上移】键/【下移】键定位所需菜单或选项，选择预设项，按【功能/确认】键进行确认以完成设置。本文档介绍菜单操作时，仅介绍菜单项的顺序，例如，进入编辑短信的路径为“短信息 -> 编辑信息”。

主菜单

功能

- 电话簿
- 短消息
- 通话记录
- 设置
- 网络管理

选项

- 日期
- 时间
- 语言
- 网络管理
- PSTN网关
- GPS网关

其他

- 任务管理
- 日历
- 定位
- 设置
- 语言
- 网络管理
- PSTN网关
- GPS网关

菜单项

- 电话簿
- 短消息
- 通话记录
- 设置
- 网络管理

其他

- 任务管理
- 日历
- 定位
- 设置
- 语言
- 网络管理
- PSTN网关
- GPS网关
直通模式（DMO）菜单

基本操作

开机与关机
开机：顺时针方向旋转【电源开关/音量控制】旋钮，开机过程中，LED指示灯亮绿灯，LCD显示开机动画，“嘟”声后，本产品进入待机界面。开机后，TMO模式下，产品自动进行登录。DMO模式下，产品开机后即可使用。

关机：逆时针旋转【电源开关/音量控制】旋钮直至听到“咔哒”声，LCD显示关机动画。

工作模式切换
本产品可以在TMO集群模式和DMO直通模式下工作。若需切换产品工作模式，待机界面下，通过【选项/返回】键进入菜单项，选择“集群模式”或“直通模式”进行切换。

通话音量调节
顺时针旋转【电源开关/音量控制】旋钮增大输出音量，逆时针旋转该旋钮减小输出音量，调节完成后，产品将自动保存设置并返回原界面。

键盘输入
通过本产品数字键盘输入用户别名、号码和编辑短信息等。本产品支持字母输入法、数字输入法和多国语言输入法。若需切换输入法，请按数字键盘上的【】进行切换。字母/数字/中文输入法下，若需输入标点符号等特殊字符，请按【】。字母/数字输入法下，按【】可输入空格。其他国家语言，请根据具体情况进行切换。

键盘锁定及解锁
待机界面下，通过【功能/确认】键进入菜单项，选择“设置 -> 键盘锁定 -> 开”，开启键盘锁功能。功能开启后，产品将在经销商预设时间后自动锁定键盘。键盘锁定后，可通过按【功能/确认】键后按【】键解锁。
除了通过菜单开启键盘锁定功能进行键盘锁定及解锁外，您还可以通过短按【确认】键后短按【】键快速手动锁定键盘。
PIN 码保护与更改
开启或关闭此功能均需输入PIN密码。初始PIN码为“1234”。待机界面下，通过【功能/确认】键进入菜单项，选择“设置 -> 保密设置 -> PIN码保护”，输入PIN码后，开启或关闭PIN码保护功能。

开启PIN码保护功能后，开机后需输入PIN码，才能使用本产品。若连续错误输入PIN码3次（经销商预设值），产品将被锁定。此时，需通过正确输入PUK码（经销商预设值为12345678）重新设定PIN码。

若需重新设定PIN码，待机界面下，通过【功能/确认】键进入菜单项，选择“设置 -> 保密设置 -> PIN码更改”，输入现有PIN码后即可设定新PIN码。

联系人管理
联系人列表
您可以通过【功能/确认】键，进入菜单项，选择“电话簿”查看联系人列表。

新增联系人
您可以通过【功能/确认】键进入菜单项，选择“电话簿”。通过【功能/确认】键进入“操作选项 -> 新增联系人”添加联系人；“新增联系人”界面下，输入联系人姓名，按【功能/确认】键进入“输入号码”，输入联系人号码，按【功能/确认】键选择号码类型为“个人号码”或“PABX”或“电话”。

查看存储容量
您可以通过【功能/确认】键进入菜单项，选择“电话簿 -> 存储容量”，查询本产品联系人存储容量及使用情况。

呼叫
TMO 模式
个呼
集群模式下，可发起半双工呼叫和全双工呼叫。半双工呼叫和全双工呼叫可通过经销商设置为HOOK呼叫或DIRECT呼叫。

发起呼叫
- 通过菜单操作
  待机界面下，通过【功能/确认】键进入“电话簿”或“通话记录”子菜单，选择所需联系人，然后按【PTT】键发起半双工呼叫，或按【功能/确认】键发起全双工呼叫。
- 通过手动拨号
  待机界面下，通过数字键盘输入联系人号码后，按【PTT】键发起半双工呼叫；通过选择号码类型为“个人号码”后，按【功能/确认】键发起全双工呼叫。

备注:
- 当您输入个呼联系人号码时，须遵循SSI&TSI拨号规则。具体参见“附录: SSI&TSI 拨号规则”。
- 若超出预设通话保留时长，通话将自动挂断。

接听和回复呼叫
- 收到半双工呼叫
  » 若为DIRECT呼叫，本产品响一声提示音提示呼叫已建立。
  » 若为HOOK呼叫，本产品将发送来电振铃提示，按【PTT】键或【功能/确认】键或直接应答该呼叫。

呼叫建立之后，双方无需进行任何按键操作即可实现通话。

挂断或拒接呼叫
呼叫建立时，被叫方可通过按【返回/选项】键或【功能/确认】键拒接接听呼叫，主叫方可通过按【返回/选项】键或【功能/确认】键结束呼叫。呼叫建立后，主叫方和被叫方均可通过按【PTT】键挂断呼叫。

组呼
发起呼叫
待机界面下，按【PTT】键对默认组（待机界面显示的组呼号码）发起组呼。若需向其他组发起组呼，请按以下步骤进行:
1. 待机界面下，旋转【组呼选择】旋钮选择所需通话组，当前通话组名称会显示在屏幕上。
2. 按【功能/确认】键选定通话组。
3. 按【PTT】键即可对该组发起呼叫。

接听和回复呼叫
您无需进行任何按键操作即可接听组呼。如需发起讲话，请在对方讲话完毕后，按住【PTT】键开始讲话。
当终端由经销商设置有话权抢占优先权时，您可按住【PTT】键强制打断对方讲话。

PABX/电话呼叫
PABX/电话呼叫为全双工HOOK个呼，下文将详述其发起方式，关于“接听和回复呼叫”、“挂断或拒接呼叫”请参考个呼相应内容。

发起呼叫
1. 选择网关。待机界面下，通过【选项/返回】键进入
PABX网关”或“PSTN网关”，按【功能/确认】键选择相应的网关。

2. 输入号码。待机界面下，输入PABX或电话号码：前缀号（由网关规定）+目的终端号码。

3. 选择呼叫类型。按选择号码类型为“PABX”或“电话”。

4. 按键发起呼叫。

紧急呼叫

发起呼叫
按【紧急呼叫】键对预设号码(个呼号码、组呼号码、默认组、PSTN或PABX号码)发起紧急呼叫。紧急呼叫有三种优先级：“紧急优先级”和“预占优先级3”。当发起优先级为“紧急优先级”的紧急呼叫时，可打断优先级为“预占优先级3”的紧急呼叫。

接听和回复呼叫
被叫方无需任何操作即可接听呼叫。主叫方讲话完毕后，您可按住【PTT】键回复。

挂断呼叫
请根据“预设号码”类型，参考“个呼”或“组呼”相应内容。

DMO模式
个呼
直通模式下，通过按【PTT】键发起半工个呼。

发起呼叫
待机界面下，通过数字键盘输入联系人号码或通过【功能/确认】键进入“电话簿”或“通话记录”选择所需联系人，然后按【PTT】键才能发起讲话。

接听和回复呼叫
您无需进行按键操作即可接收。主叫方讲话完毕后，您可按住【PTT】键回复。

短信

状态信息
您可通过经销商将经常使用的短消息设置为状态信息。状态信息不能编辑，只能发送和查看。发送成功后，若目的终端未设置“状态信息”，则会收到状态信息。若目的终端设置该码的状态信息，则将收到本终端状态码对应的信息内容。

用户信息

TMO模式
编辑
通过【功能/确认】键进入“短信息 -> 编辑信息 -> 用户信息”，进入短信编辑界面。

发送

备注：若您要发短信息，可以上界面看到信息的全部内容。若信息呈显示蓝色，将会自动降级为低优先级。

查看
当界面出现，表示您有未读短信息，您可以通过以下两种途径查看：

DMM模式
编辑
通过【功能/确认】键进入“短信息 -> 编辑信息 -> 用户信息”，进入短信编辑界面。

发送
编辑完短信后，通过【功能/确认】键进入发送界面，向个人或组发送短信。

查看
同TMO模式。
故障处理指南

<table>
<thead>
<tr>
<th>故障描述</th>
<th>原因分析</th>
<th>解决方法</th>
</tr>
</thead>
<tbody>
<tr>
<td>无法开机</td>
<td>电池电量过低</td>
<td>为电池充电。</td>
</tr>
<tr>
<td>网络注册失败或找不到网络</td>
<td>处于直通模式</td>
<td>切换至集群模式。</td>
</tr>
<tr>
<td></td>
<td>未在服务区内</td>
<td>检查信号强度，保证位于服务区内。</td>
</tr>
<tr>
<td></td>
<td>未获得网络授权</td>
<td>联络网络运营商获得网络授权。</td>
</tr>
<tr>
<td>建立呼叫失败</td>
<td>本产品或目的终端未在服务区内</td>
<td>查看信号强度确保终端在服务区内。</td>
</tr>
<tr>
<td></td>
<td>未切换至正确通话模式</td>
<td>确认各终端处于正确的通话模式。</td>
</tr>
<tr>
<td>无法发送/接收组呼</td>
<td>未加入该通话组</td>
<td>确保终端已加入该组。</td>
</tr>
<tr>
<td></td>
<td>未获得通话组的授权</td>
<td>联系网络运营商获取权限。</td>
</tr>
<tr>
<td>正常通话被打断</td>
<td>收到优先级更高的呼叫或紧急呼叫</td>
<td>待其它呼叫结束后重新建立通话。</td>
</tr>
<tr>
<td>半双工呼叫建立过程中被终止</td>
<td>呼叫建立超时</td>
<td>保证呼叫建立时间不超过预设定时间。</td>
</tr>
<tr>
<td></td>
<td>优先级更高的终端在请求建立呼叫</td>
<td>待其呼叫结束后重新建立呼叫。</td>
</tr>
<tr>
<td>通话中意外掉线</td>
<td>网络繁忙，网络资源被分配给其它业务</td>
<td>待网络空闲时重新建立呼叫。</td>
</tr>
<tr>
<td>收发端状态信息内容不一致</td>
<td>两终端状态信息ID定义不一致</td>
<td>确保两终端状态信息ID定义一致。</td>
</tr>
</tbody>
</table>

如上述方法仍未解决您的问题，或您遇到一些其它故障，请联系当地经销商或我司以获取更多的技术支持。

保修范围与期限

我司承诺，凡我司生产的产品，自购买之日起，在正常使用、操作与维护条件下，出现材料或制造工艺方面的缺陷，可享受以下规定的保修服务。

<table>
<thead>
<tr>
<th>产品类型</th>
<th>保修期限</th>
</tr>
</thead>
<tbody>
<tr>
<td>电池、充电座、电源适配器</td>
<td>12个月</td>
</tr>
<tr>
<td>主机</td>
<td>24个月</td>
</tr>
</tbody>
</table>

保养与清洁

为了保证本产品发挥其良好性能，延长其使用寿命，请熟悉以下内容，以便更好地对本产品进行日常保养与清洁。

保养
- 请勿用硬物穿刺或刮花本产品。
- 请勿将本产品存放于含有腐蚀电子电路物质的环境。
- 携带或使用本产品过程中，请勿用手提天线或耳机线。
- 当不使用附件时，请盖好附件接口盖。

清洁
- 在您进行清洁之前，请关机并断开电源。
- 请定期使用洁净干燥的无绒布或毛刷拭去本产品表面及充电极片附着的粉尘。
- 本产品的按键、控制旋钮和机壳极易变脏。可用中性洗涤剂和无纺布对其进行清洁，请勿用去污剂、酒精、喷雾剂或石油制剂等化学药剂进行清洁，以避免产品表面和外壳受损。
- 清洁之后，务必保证本产品彻底干燥，否则请勿使用。
选购配件

本产品主要的选购附件已包含在如下列表中，如需更多附件信息，请咨询您当地的经销商或拨打我司服务热线400-830-7020。

注意：请使用我司指定的配件。若擅自使用未经许可的配件，则由此所导致的一切后果，由用户自行负责。

电源类:
MCA05 电池分析仪
BL2505 锂离子电池 (2500mAh)
MCA06 锂电/镍电MCU快速排充
MCA08 锂电/镍电MCU快速排充
CH10A06 锂电/镍电MCU双插槽充电座
CHV09 座充车载电源适配器

音频类:
ESN12 耳塞式耳机
EHN16 C型耳挂式耳机
EHN17 可调节耳挂式耳机
EWN09 无线项挂式耳机
EAN23 分体式透明管耳机
EAN17 三线透明管监控耳机(米色)
EAN18 三线透明管监控耳机(黑色)
SM18N5 防水扬声器话筒(IP67)
SM18N3 防水扬声器话筒(IP54)
ES-01 只接收耳塞式耳机（适配SM18N3）
EH-01 只接收C型耳挂式耳机（适配SM18N3）
EH-02 只接收可调节耳挂式耳机（适配SM18N3）
ES-02 只接收透明管耳机（适配SM18N3）

其他:
LCY003 携带外套(薄电)(真皮)(可旋转)
LCY006 携带外套(厚电)(真皮)(可旋转)
PC36 编程连接线(USB转串口)

附录

SSI&TST 拨号方式

在TETRA系统中，通过识别码来识别用户。识别码根据长度可分为TSI（TETRA用户识别码）和SSI（TETRA短用户识别码）。TSI由MCC（国家代码）、MNC（网络代码）和SSI（短用户识别码）构成。发起呼叫时，需拨打相应的用户识别码。下述各内容仅适用于发起个呼。

本产品所支持的拨号方式包括：SSI&TST、PABX和PSTN（电话）。本节只介绍SSI&TST拨号方式，关于PABX和PSTN（电话）拨号方式请参考8.3.1 PABX/电话呼叫：

- 若使用SSI拨号方式，输入的号码位数不能超过8位。
- 若使用TSI拨号方式：
  - 当需输入MNC和SSI时，SSI 须为 8 位，不足时在首位前补0，MNC 输入实际位数，例：当MNC=20且SSI=504时，输入2000000504即可；
  - 当需输入MCC、MNC和SSI时，SSI 须为 8 位，MNC 须为 4 位（当MNC不足4位时，请补足4位）或 5 位（MNC为5位），MCC 须为 3 位，不足时在首位前补0，例：当MCC=460、MNC=20且SSI=504时，输入46000200000504即可。